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SimSail is a numerical simulation tool because it artificially reproduces the operation of a sailboat in its 

environment using a computer program, for study, explanation or forecasting purposes. 

In artificial intelligence, the method of isochrones used for routing is described as an optimization 

metaheuristic based on a greedy algorithm. The greedy algorithm makes an optimal choice at each step 

(isochrone) with the idea of finding the optimal solution to solve the problem as a whole. However, this 

approach still fails to find the best route with certainty. Indeed the algorithm makes decisions only according 

to the information available to it at each step, without taking into account the overall problem.  
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SimSail 

Édouard HALBERT 

http://www.simsail.net 

 

OVERVIEW 
SimSail is a free software for planning sailing routes. It allows to find the best route by visualizing the conditions 

encountered in navigation. 

The strength of SimSail is to access a very large number of parameters. If current data exists, the wind received 

by the boat for the calculation of the routing will be the wind-surface resulting from the combination of the 

current and the wind, which corresponds to the reality. 

The routing can be multi gribs of wind and current, multi road segments and multi-boats including 

compensated times from ratings. 

SimSail can be connected to a navigation data system in order to analyse the performance of the boat and 

compare the actual navigation data with the routing. 

Like any simulation tool, SimSail requires some time to exploit it. The interface tries to reduce the complexity 

of the software by grouping the functions and allowing a quick access to the most used functions. 

SimSail is not to replace any skill of a skipper.  At sea, a skipper has the ultimate responsibility of the crew 

and the boat: "Skipper Word is Law" ... not SimSail. 

http://www.simsail.net/
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FEATURES 

Navigation 
- Maps raster SnMap (sold by ScanNav®) 

- Maps BSB, OpenStreetMap (and OpenSeaMap) and Google Maps® 

- World coastlines with coastal cities and capitals 

- Mercator projection and Great circle with full scrolling in longitude (infinite map) 

- Bathymetry (European Marine Observation and Data) 

- Connection to instruments (serial or wifi) with display of the boat and all the navigation data 

- Laylines upwind and downwind 

- Repeaters with graphs 

- AIS (Automatic Identification System) with list of targets 

- Complete tool of measure of distance 

Weather 
- Grib file of wind (edition 1 and 2) with display of wind, gusts, isobars, precipitation, humidity, total 

cloud cover, temperature and convection 

- Grib files of currents and waves (edition 1 and 2) 

- All gribs of wind and current can be modified in intensity and lag 

- Atlas of currents from Belgium to La Coruña (Spain) 

- Reading of SHOM tidal streams (must be purchased from the SHOM website)  

- Direct request of gribs from Great Circle® (subscription required at Great Circle®) 

- Email requests for Saildocs® and Great Circle® 

- Weather graph and Tide graph 

Routing 
- Automatic routing or control of all parameters 

- Routing sailing, dual with sailing and motoring with fuel consumption and, motoring only 

- Routing by Isochrones or by Course made good 

- Routing on multiple legs of route 

- Routing from the boat and/or to the active waypoint 

- Routing with multi gribs of wind and current 

- Integration of the current into all routing calculations (wind and boat) 

- Avoidance of coasts and barriers defined by the user  

- Avoidance of thunderstorms, weak or strong wind and high waves  

- Multiple routings by scan of variables (polar, wind – strength & lag, current – strength & lag, time of 

departure and several boats) 

- Numerous tools of visualization of the routing (display of all conditions met on a route step by step and 

global statistics) 

- More than 500 polars provided with possibility to modify them1 

- Analysis of the corrected times between different boats 

- Progress table 

- Routing time step from 1 min to 6 hours 

- Selector of configurations of boat (4 configurations) for rapid access 

- Loss of speed integrated during tack 

                                                           
1 some come from www.sailgrib.com 

https://www.scannav.com/
https://www.google.fr/maps/@48.3255216,-0.4318736,7.25z
https://www.shom.fr/
https://www.squid-sailing.com/en/content/91-subscriptions-comparison
http://www.saildocs.com/
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Functionalities 
- Auto save of the session of work 

- Record and analysis of trace (NMEA) 

- Trace converter to CSV format 

- Tests of performance at sea between intervals of time 

- Simulation in order to configure repeaters 

- Languages: French, English, Dutch, Spanish 

- Routes, marks, barriers and TSS in GPX format 

- High DPI Screen compatible 

LICENSE 
SimSail is delivered under Creative Commons Attribution-NonCommercial-NoDerivatives 4.0 International 

License. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT 

NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 

NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES 

OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 

CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 

Messages of satisfaction, reports of bugs and ideas of development can be sent to 

edouard.halbert@gmail.com. But, before you send me an email, I highly recommend reading this manual. 

SimSail is provided as is. This means that nothing is guaranteed, not even your satisfaction. If you are not 

satisfied, needless to say, uninstall it, that's all. 

INSTALL 
SimSail is in two folders:  

- The program and non-modifiable files are normally under Program Files, depending on the choice of the 

user during the setup; 

- Data, which includes the grib files, are under User / Documents / SimSail. 

It might be necessary to run the “vc_redist.x86.exe” file which is in the SimSail folder, normally in “C:\Program 

Files (x86)\SimSail”. 

HIGH DPI SCREEN 
SimSail supports high DPI screens. If problems occur, in Windows 10, go to Parameters > System > Display 

and move the cursor to the left. 

SHORTCUTS 
The key [F1] displays all the shortcuts. 

Two shortcut keys are important to know: 

[TAB] key opens the dialog box where all parameters are; 

[SPACE] bar launches a routing; 

The mouse wheel on the wind, wave and current icons allows to change files. 
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INTERFACE 
SimSail has a user-friendly interface with direct accesses. The panels (on the left in the following screen 

capture) are displayed only when a routing is displayed.  

The icons presented in this manual are the icons of Set 1 but by default, this is the Set2 displayed. To display 

those of Set 1, open the file "Config.ini" normally located in "Documents / SimSail / Config" and set Set1 to the 

MainIcons parameter. 

  

 

The status bar at the bottom of the main window displays the information at the mouse position: wind, gust 

of wind, pressure, cloud cover, precipitation and current. 

 

Main bar 

 

 

  

ALL PARAMETERS WIND WAVES TIME MAP BOAT CURRENTS & 

TIDES 

Visualization 

of the 

routing 

Main menu 

Time bar 

Global 

results 

Detail of the 

routing at a time 

step 

Status bar 
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The parameters window opens with the [TAB] key or by clicking on the first left icon in the main menu. 

Most buttons on the main bar have two functions. We select with a left click and change the function of a 

button with a right click. Icons of Set2. 

 LEFT CLICK  RIGHT CLICK 

 

Access to all control settings   

 

Show the arrows of the wind 
 

Arrows on the grid of definition of the grib 

 

Show wind gusts   

 

Display the wind gradient in 10 colours 
 

Gradient of wind with figures  

 

Show the cloud cover with numbers 
 

Cloud cover without figures 

 

Show the convection with numbers 
 

Convection without figures 

 

Show the precipitation with numbers 
 

Precipitation without figures 

 

Show the humidity with numbers 
 

Humidity without figures 

 

Show the temperature with numbers 
 

Temperature without figures 

 

Show the isobars 
 

Pressure gradient 

 

Show the waves 
 

Waves on the grid of definition of the grib 

Date Set the date at the moment  
 
 

 

Display the arrows of currents 
 

Gradient of currents 

 

Display the tides   

 

Display the coastlines 
 

Coastlines with map grid 

 

Display raster maps (BSB or SnMap) 
 

Raster maps with map grid 

 

Display OpenStreetMap from internet 
 

OpenStreetMap from the cache 

 
Bathymetry 

 
Bathymetry with safe depth 

 

Display the waypoints 
 

Waypoints in small, medium and big format 

 

Centre the boat on the screen 
 

Open the configuration of the boat 

 

Display the repeaters 
 

Open the configuration of the repeaters 

 

Open the analysis of performance   

 

Display the AIS targets on the screen 
 

Display the list of the targets in a window 

 

Switch to MOB mode   
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Language and style of window 
The choice of language is in Parameters > Options > Interface. The main SimSail window may not have a title 

bar. In Settings > Options > Interface, click on the "Without title bar" button. Accept then close and open 

SimSail for the changes to take effect. 
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CHARTING 
All displays of SimSail meet the great circle (great circle on the surface of the earth that guarantees the shortest 

route). A route does not cut the meridians at a constant angle. This can be verified by creating a route about 

100 miles in SimSail. The starting bearing is viewable by putting the mouse cursor on the beginning of the 

road. It is different from the arrival bearing (cursor on the route near the end waypoint). 

The projection of the map is Lambert and coordinates are WGS 84 format. 

The world shorelines are available with 5 levels of detail as well as raster maps BSB and SnMaps and free maps 

available on internet like OpenStreetMap or Google Maps. The accuracy of the charts is greater than the 

accuracy of the coastline. 

 

Coastlines 
SimSail is delivered with 5 levels of details got from http://www.soest.hawaii.edu/pwessel/gshhg. 

A very high level can be added with the support of OpenStreetMap. 

 

Coastlines 

OpenStreetMap 

Raster 

http://www.soest.hawaii.edu/pwessel/gshhg
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The link “OpenStreetMap Data” download, via the internet browser, a file named 

« coastlines-split-4326.zip ». Decompress it in order to obtain a folder named 

“coastlines-split-4326”. The folder has the following files: 

 

Now, click on 

 

Open the file “lines.shp”. SimSail converts it and creates a new file named “poly-o-1.dat” siutaued in the 

folder “Data / Gshhs” of SimSail (normally under Program Files). 

Please note that this very high definition file can slow down the rendering of SimSail. 

Charts Raster 
SimSail can display raster maps like BSB (extension “kap”). To do this, it is mandatory to specify the folder 

where are the maps. Several folders are possible. For information, SimSail doesn’t modify the content of the 

folders. 
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Example of BSB chart 

 

Charts SnMap from ScanNav 
These raster charts offer must be purchased on ScanNav website at https://www.scannav.com 

This raster charts offer is derived from data provided by the SHOM, UKHO, BSH and IIM/Navimap. Charts are 

updated twice a year. Although the look is similar, they are not scanned from paper charts, but issued from 

the printing films, which eliminates manipulation errors, and facilitates regular updates. 

- Channel: from the Belgian border to Pointe St Mathieu, Channel Islands included (SHOM) 

- Atlantic: from Pointe St Mathieu to the Spanish border (SHOM) 

- Mediterranean: from the Spanish border to the Italian border, including Corsica (SHOM) 

- United Kingdom + Ireland (UKHO) 

- Spain + Portugal (UKHO 

- Azores, Madeira, Canary Islands, Cape Verde (UKHO) 

- Lesser Antilles: From Grenada to Puerto Rico (UKHO + SHOM + NOAA) 

- Italy (NaviMap-IIM) 

- Croatia (UKHO) 

- Netherlands + Belgium (UKHO) 

- Germany (BSH) 

 

SimSail strongly encourages the use of these charts. 

When purchasing, in the comments of the order form, you should mention that the charts are for SimSail. 

With the link provided in response to the purchase, choose the zip file. 

https://www.scannav.com/FR/PackRaster.php?PHPSESSID=685jbmf1brjt4lsi3r3oue57s6
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Example of SnMap chart 

 

In order to install the SnMap maps, open the dialog box “License…” being connected to Internet. Fill in the 

form and perform the registration online.  

 

Decompress the zip and place the charts into one or several folders and inform SimSail where they are and 

specify to SimSail where they are located. Now, the charts are now visible. 
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This procedure should be repeated for each new pack of charts. 

Charts OpenStreetMap & Google Maps 
Areas can be pre-loaded for rendering on a computer which is not connected to internet, or at sea. For this, 

select a zone. Right click on the map and click "Select a zone". Then draw a rectangle with the left button of 

the mouse. You can move and change the area later with the mouse. When the area seems OK, right click and 

select "Download OpenStreetMap." 

 

This opens a window that allows you to cache all the tiles from the area at the desired zoom levels. 
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Several choices of free maps are offered, including Google Maps. 

Please note that the download time and the amount of data can quickly be 

important.  

 

 

 

 

 

 

 

 

 

Google Maps with Nautical charts 
By selecting the Raster and OpenStreetmap icons, we obtain a breakdown of the terrestrial maps: 
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Bathymetry 
Open Parameters / Route / Bathymetry. 

 

In order to install a bathymetry file, click on the link « European Marine Observation and Data ». This link 

opens an internet address on the browser at https://portal.emodnet-bathymetry.eu/# 

Click on Downloads. 

 

Click on DTM Tiles. 

 

Select one or several zones. 

https://portal.emodnet-bathymetry.eu/
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For « Product format », select ESRI ASCII then click on Download product selection ». 

Fill in the form. In "Usage", put what you want (example: 

navigation) then submit the request. The email address is 

important because you will be able to download the file from the 

email received. 

 

 

 

 

 

 

 

 

The downloaded file resembles to E4_2020.zip. Decompress it in a folder the convert. You get a E4_2020.asc 

file. The convert it. 

 

The new file adapted to SimSail is placed at “Documents / SimSail / Bathy”. 

LOAD GRIBS 
Gribs can contain a large number of parameters for a given area and duration. In SimSail, we are only 

interested in the data related to air (including wind), currents and waves. 

A grib file can be obtained in several ways.  

If you get a grib file from another software, copy or move the grib file to the folder “Documents / SimSail / 

Gribs”. As such, SimSail recognizes the grib and open it when it starts. 
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With SimSail, right-click on the map and click "Select Area". With the mouse, draw a zone by keeping the left 

button pressed. The area is then editable with the mouse in position and size by placing the mouse on the 

edges of the area or in the area to move it entirely. 

When the zone is correct, right click and select "Ask a grib". A window appears that allows you to make a 

request by email or to download directly the gribs if the user has a Great Circle account https://www.squid-

sailing.com/en 

 

 

The Great Circle service is only available when an account is valid. Click on the "Great Circle Account" button. 

Fill in your login and password and download the areas corresponding to the subscription. 

https://www.squid-sailing.com/en
https://www.squid-sailing.com/en
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The Great Circle service is by far the best for an affordable price.  

https://www.squid-sailing.com/fr/content/91-tableau-abonnements-squid 

The right part at the bottom of the "Ask a grib" window allows you to save grib configurations as below: 

 
Select the Great Circle service, select the models, variables, duration and area and click on "Create ...". Give 

a name to the configuration as in the example above, "Manche". 

  

https://www.squid-sailing.com/fr/content/91-tableau-abonnements-squid
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The creation of a download configuration makes it easy to download the gribs concerned. Right-click on the 

map anywhere and select "Grib Download" and select the configuration. The download of all the gribs in the 

area starts. 

 

When all downloads are complete, the wind grib is displayed on the screen. 

START A ROUTING 
At start up, SimSail restores the working environment of the previous session. These parameters are in a file 
named “Config.ini” normally located in "Documents > SimSail > Config”. This file can be edited using a text 
editor (at your own risk). 
 
1) LOAD A WIND GRIB in SimSail. [Tab] key or first left icon in the main menu (top of screen), then "Forecast" 

and "Wind Grib" then "Add" button. 

A grib file can be obtained in several ways. 
 
- With SimSail, with the previous method 

- With zyGrib (http://www.zygrib.org) you can download a grib. Its interface is very intuitive but the 

current version 8.0 does not take into account the "high definition" files. Like the previous method, you 

must transfer the grib file to the folder named "Gribs" located in the working directory SimSail. 

- With XyGrib software (https://opengribs.org) which is similar to zyGrib. 

- With Squid® (http://www.squid-direct.squid-sailing.com), a subscription (one is free), the choice is vast 

and some gribs have a very high definition (AROME HD model of Météo France, for instance). A tip is to 

configure the download folder of Squid® as the Grib folder of SimSail. As such, no transfer to do. 

When a grib is loaded, the winds are displayed on the map. The main toolbar at the top of the window is 

updated with the time range of the file. You can navigate from the first layer to the last with the arrows of the 

keyboard (+ CTRL for 10 min or SHIFT for 1 min). With the icon "clock", you can set the date and the time to 

the current date time. 

 

Each light grey/dark grey rectangle represents a day. The grey lines above and below represent the weekends, 

Saturday and Sunday. The small vertical black line represents the current date and the vertical black line 
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represents the selected date. The blue rectangle represents the current. The green line represents the waves 

grib. 

You can navigate in the wind file by clicking on the bar or using the arrow keys: [Left] or [Right] to move 

backward or forward one hour (round time) and [Up] or [Down] for 3 hours, [Control] + [Left] or [Right] for 

10 minutes, [Shift] + [Left] or [Right] for 1 minute.  

In practice, roughly position the date and time desired then refine with the arrows. 

All the gribs can be modified: 

 
 

- Only one grib is displayed (highlighted in blue) in SimSail but several gribs can be selected for a routing; 

- The checkboxes identify the gribs selected for the routing and not the ones displayed in SimSail; 

- A panel of information appears when the mouse is over a checkbox; 

- Click on a line (column: Gribs, Grid, Hrs) selects the grib to display. Only one grib can be displayed. A double 

click on a line selects only a grib and deselects all the others; 

- %: a left click on this column allows to modify the strength of the grib; 

- Lag: a left click on this column allows to move forward or backward the grib (Time lag); 

- Pri (priority): a left click on this column allows to change the priority of the grib. 

 

2) The CURRENTS of the Channel, Iroise Sea and Biscay Bay are present in SimSail by default. You cannot 

change them but you can add the currents of the SHOM (French Oceanographic Agency, see installation) or 

Gribs of currents. 

Below, 3 currents are available: the atlas by default, the SHOM and one grib of current (myocean_ibi_...). The 

latest are obtained with a software like Squid®. 

Selection of 

the gribs for 

the routing 

Selection of 

the grib to 

display 

Strength  of the grib 

Time lag of the grib 

Priority of the grib 

for the routing 
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3) CREATE A ROUTE. Right click on the map and select “Create a route”. Left click to add waypoints. The 

number of waypoints is not limited. When you have finished, hit the [ESC] key or right click. You can save the 

route or load an existing one. You can move, add or delete all the waypoints. You can also prolong the route, 

reverse it or replace it by a new one. 

 

4) Set the TIME OF DEPARTURE using the arrows of the keyboard ([Left] or [Right] for 1 hour, [Up] or [Down] 

for 3 hours, [Control] + [Left] or [Right] for 10 minutes, [Shift] + [Left] or [Right] for 1 minute). 

 

5) LAUNCH THE ROUTING 

Button "Start routing" at the bottom of the parameters control window or, if the window is not open, press 

the [SPACE] bar. The time bar is replaced by a progress bar. Routing can be interrupted at any time by pressing 

[ESC]. 

You can navigate on the simulated route using the tool time below the main tool bar or with the [Left] or 

[Right] Arrow. 

 

  

Selection of 

the gribs for 

the routing 

Selection of the 

current to display 

Strength  of the grib 

Time lag of the grib 

Priority of the grib 

for the routing 
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6) ANALYSE THE RESULTS 

Hit the key [²] to access to the global results (key above the tab key). 

 

 

 

 

 

 

 

 

 

 

 

 

 

The key [R] gives access to the previous 

routings. The routings are listed. They can 

be displayed or not (checkbox at the left of 

the names). They can be deleted (checkbox 

at the ight of the names). Only one can be 

selected (marked as “ON”). 
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ALGORITHM OF ROUTING 
SimSail reads the gribs (editions 1 and 2) of wind and current. SimSail reads the data of the SHOM (to purchase 

on the SHOM website). SimSail can route with a unique wind (constant on the earth) that may vary in intensity 

and direction. 

The routing can use several gribs of wind and current. SimSail computes the wind and the current depending 

on the priority of the selected gribs (Parameters > Forecasts > Wind Grib and Parameters > Forecasts > 

Current). 

The gribs of wind and current can be modified in intensity and in time (lag). In general, 115% is a good value 

for a grib of wind. In the Channel, the real current is often stronger than the files (gribs or SHOM). 

The grib of wind and the grib of current are linearly interpolated in space and time. It means that, for any 

position, SimSail interpolates four grid points that surround the position to calculate. If one point is missing, 

SimSail takes the closest point of the grid, p1, p2, p3 or p4. 

This interpolation is performed for the previous layer of the grib and for the next layer. The 

result interpolates the two layers as a function of time. Example, the wind grib provides the 

data for 8:00 and 9:00. The calculation seeks a value for 8:00 (between the four grid points that 

surround the wanted point) and 9:00. Then, the final result is that for the time searched 

between 8:00 and 9:00. 

Because the SHOM’s current, as well as the default one provided by SimSail for 

the Channel, is based on an irregular grid, the interpolation of the current is 

questionable in some cases (especially the front of tide between different 

density zones of power points). The method that would be the most fair 

(kriging) requires several passes and necessitates some time. The 

interpolation on regular grid gribs will therefore be preferable to 

interpolate an irregular grid. 

The polar of the boat is interpolated using two methods: a linear interpolation between points and with a 

bicubic-spline on the full range of the data. Linear interpolation brings small errors between points. Spline 

interpolation implies that the polar should have all data defined for all its lines or its rows. Wind values higher 

than the polar file are not extrapolated. If the polar stops at 20 knots of wind, then a speed boat for a wind of 

24 knots will be that of the wind 20 kt. This is the limit to be considered in strong winds because the sea 

conditions can significantly reduce the performance of the boat. Generally, polar issued from velocity 

prediction programs are optimistic in low wind and high wind. The edition tool of the polar authorizes the user 

to correct individually each line of the polar. 

It is wise to check if the polar can be interpolated with the bicubic spline method. If not, uncheck the option 

“Bicubic interpolation”. The polar below is correct because it shows no irregularity. 
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The polar can be changed in intensity. For cruising, for example, (winder, hood, boat load, hull unprepared, 

etc.), it will be wise to put a coefficient much less than 100%. The intensity of the polar may be different during 

the night. This is the case of a cruise being underpowered or leaving the driving to the pilot. In SimSail, night 

matches nautical twilight that is the period when the centre of the sun is 12° below the horizon. 

The VMG upwind angle can be degraded. If the effectiveness of the polar can be modified, it doesn’t reflect 

the fact that, outside certain specific conditions of regatta, a sailing boat cannot respect the VMG upwind 

angle of the polar. This parameter is useful in case of autopilot. 

SimSail can route on multiple route segments. There is no limit to the number of segments. Right-click on the 

map is used to display a menu that offers to create a route. You can move, add and delete all waypoints. You 

may be asked to check if a waypoint is on ground (Parameters > Route > Route). Note that the routing cannot 

start if the first waypoint is ashore. A waypoint on ground appears differently. No route segment may be less 

than 0.5 nautical mile. 

SimSail performs all calculations in great circle. It guarantees the shortest route on the surface of the earth. 

The route does not cut the meridians with a constant angle. This can be verified by creating a route about 100 

miles in SimSail. The starting bearing is viewable by putting the mouse cursor on the beginning of the route. It 

is different from the arrival bearing (cursor on the route near the end waypoint). All displays of SimSail meet 

the great circle. The projection of the map is that of Lambert and coordinates are WGS 84. The world coast 

line is available as well as free charts provided on internet. The precision of the charts is greater than the 

precision of the word coast line. 

SimSail avoids the coasts constituted by the world coastline. The quality of the coast is configurable 

(Parameters > Route > Obstacles). Higher it is and more accurate is the calculation but the computing time is 

longer. The quality of the coast considered in the routing calculations (Parameters > Route > Obstacles) is 
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different from the quality of the map displayed on the screen that depends on the zoom of the chart displayed 

in the screen. 

SimSail avoids obstacles created by the user. There are several ways to create obstacles in creating a route 

and converting it in a barrier (Parameters > Route > Route), or creating a barrier manually (right click on the 

map and “New barrier”). All points are modifiable (deletion/addition/removal). All obstacles can be saved and 

recalled later. 

Marks can be passed on a specific side. Create a route that passes over a mark 

and create a barrier of two points (one of them is the mark). 

In this case, the mark is let to starboard. 

 

 

 

 

Traffic separation schemes (TSS) are not obstacles for routing. By creating a route that takes the form of a TSS, 

it can be converted to the format of a TSS or an obstacle (Parameters > Route > Route). One can also create a 

route in a navigation software, import it into SimSail and convert it to TSS or obstacle. In fact, any route in GPX 

format is either a route or a TSS or an obstacle to SimSail. It depends on the storage location of the file. If a 

GPX file is in the "Routes" folder, it will be considered as a route. The same file in the "Barriers" file will be 

considered as an obstacle. And the same file in the "Tss" folder will be considered as a TSS. 

SimSail can avoid areas of weak or strong wind (Parameters > Forecasts > Wind). 

SimSail can route with the engine on when the boat speed becomes low under sail (Parameters > Boat). 

Consumption of fuel is calculated on the route. 

SimSail offers two routing methods, a method called "best course" and the method of isochrones (Parameters 

> Method > Method). 

The method called "best course" is very basic. At each time step, SimSail seeks to reach the next waypoint 

along the most approximate heading. When approaching the edge is on the other tack or jibe SimSail turns. 

When the route is completely upwind SimSail turns constantly at each time step. When it meets the coast or 

an obstacle, the routing stops. This method is very limited but allow to see what would make a boat that would 

have only instant weather information. This method does not calculate an optimum route, in contrast to the 

isochrones method. 

The isochrones method is more computationally expensive but gives optimal results. At each time, the boat 

tries many directions and continues the same process from each. A line connecting all routing points that allow 

the boat to arrive at a specific time is called an isochrone (literally "the same time"). Isochrones are calculated 

successively until an isochrone line exceeds the ending waypoint of a route segment. In this case, each point 

of routing of the penultimate isochrone seeks to reach directly or indirectly (with tack or jibe possibly) the end 

waypoint segment. The optimal route is calculated from the routing point that reaches the fastest to the last 

waypoint and back to the starting waypoint. The result shows that very often the direct route is rarely the 

fastest. 

Whatever is the method, SimSail estimates the time step for each segment of the route. For each, SimSail pre 

determines a time step by taking the polar and by performing a ratio between different speeds (near, reaching 



SimSail User Manual – Version 5.9 

27 
 

and bearing). On average, for a quality routing "normal" (Parameters > Method > Method -> Quality) SimSail 

seeks to calculate about thirty isochrones. The time step is proportional to the length of each segment. This 

ensures optimal results. 

The time step should be commensurate with the precision of wind gribs and current and that of the polar. In 

practice, it is best to avoid extremes. A routing time step of 15 minutes on a 16-day wind grib is extreme. It is 

the same for a time step of 6 hours when the wind file has a very high definition (AROME model of Météo 

France for example). Everything is a matter of judgment. In both cases, the result is not wrong. It is even just 

scientifically but as the data are not consistent, the interpretation is questionable. 

In the isochrones method, in manual mode, the aperture angles and their number can be changed as well as 

the time step. In this case, the time step is the same for all segments. 

Overall, it is best to use for the isochrones method the automatic mode and adjust the quality of the routing 

between from "Ultra Low" to "Ultra High". The choice of quality "Normal" gives good results (speed of 

calculation versus accuracy of routing). 

Each routing point is calculated as follows. 

The wind (TWD and TWS: True Wind Direction and True Wind Speed) and current (CD and CS: Current Direction 

and Current Speed) are interpolated to the precise position of the point and specific time point. SimSail tests 

all selected gribs files starting with the one that has the highest priority and continues until a grib is valid in 

space and in time for the point. 

The current is then combined with the wind to 

achieve a surface wind (SWD and SWS: Surface 

Wind Direction and Surface Wind Speed). This 

gives a wind angle in the polar which is 

interpolated to get the boat speed (BS: Boat 

Speed). If the tested angle is too close to the 

upwind or downwind, the optimum angle of 

upwind or downwind is retained (VMG angle). 

The speed and the boat heading are combined 

with the current to obtain a speed and a course 

(SOG and COG). The apparent wind values are 

calculated (AWA, AWS: Apparent Wind Angle 

and Apparent Wind Speed). 

 

Here is another representation of the wind vectors, current and boat. 
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The tack time is taken into account using Parameters > Boat > Boat -> Tacking. Two parameters are needed: 

the loss of speed when tacking and the time taken to regain speed before tacking. The loss in tack is interesting 

only for short upwind routes. 

If the boat speed (on water - BSP) is below a set value, SimSail drives motor if this option is selected 

(Parameters > Boat > Boat). SimSail routes with the engine when the wind data are not available and if the 

"No routing outside the grib" is not selected. 

The sea state can be taken into account due to a percentage rate defined in Parameter > Forecasts > Sea state. 

The upwind can slow the boat and downwind may accelerate it. The crosswind is neutral in all cases (no effect 

of this parameter). 

At the start of a route segment and according to the selected options, SimSail sweeps many angles. SimSail 

eliminates some of which are abnormal, e.g. those between the upwind (0°) and the optimal angle of upwind 

to this wind force (VMG) and those between the downwind (180°) and the optimal angle of descent this wind 

force (VMG). The optimal angles upwind and downwind are calculated precisely for all wind strengths. For 

example, if the polar contains the values for 10 kt and 12 kt, and the wind from the surface of gribs is 10.37 kt 

and tested angle is 20° (very close to the wind) during scanning, the point of routing will take into account the 

optimal angle for the wind strength (10.37 kt), for instance 42.18°. 

Routing points that arrive behind the preceding isochrone are removed from the calculation. It is the same for 

the points that cross behind the isochrone being calculated. This is necessary to avoid the exponential inflation 

of routing points. Indeed, the first isochrone may be based on the calculation of 70 points (70 different 

directions from the first waypoint). But if the routing adds each time 70 new points to the previous point, the 

calculation time can exceed the life expectancy of the user (the fourth isochrones has already more than 24 

million of routing points). The calculation algorithm so cleans routing points to maintain reasonable number. 

Nevertheless, a route of one segment (two waypoints, a start and a finish) calculates around 30000 routing 

points in a few seconds and give the optimal route with 30 isochrones. 

Another way to reduce the computing time is to isolate the routing in an ellipse that passes through the 

departure and arrival waypoints (Parameters > Method > Method -> Ellipse). The "ellipse" option is available 

in the isochrones method. The width of the ellipse is configurable. The number of routing points is proportional 

to the aperture of the ellipse. When this option is not selected, routing points are more numerous. 

The routing stops when SimSail finds an optimal route. However SimSail can also stop when there is no solution 

for the route: this is the case when routing cannot avoid the coast or an obstacle, or when it cannot avoid a 

minimum or maximum wind zone, or it happens when outside a wind grib (in space or time). A window will 

appear to specify the reasons that blocked the route. 

 

The example above shows two reasons. 
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1) No road can bypass the ground to reach the end waypoint. You either expand the ellipse or uncheck this 

constraint or change the route by adding a waypoint that skirts the coast, or increase the quality of the routing 

(which decreases the time step). 

2) The minimum wind constraint cannot be met. In this case, a minimum of 10 kt wind was requested. 

It is up to the user to discern which parameter to change. Statistics help. 

 

SimSail can simulate the passage of a front using the unique wind (Parameters > Forecasts > Unique wind). 

When selecting multiple dates, the wind can change in force and direction. The change is gradual and extends 

over the entire length of a period (between two dates). The unique method is interesting in the case of a 

record. 

SimSail can scan routing parameters such as polar, wind and current force and time lag and the start time 

(Parameters > Method > Scans). 

SimSail can route several boats at the same time on a course and give the result of corrected time (Parameters 

> Method > Scans). This is useful for regatta organizers in search of balanced course and well prior gribs are 

released. 

MOTOR ROUTING 
SimSail can easily perform a motor routing entirely. Three actions are required to perform a routing engine 

whose interest is that routing takes into account current. 

1) Parameters > Forecasts > Wind Grib, uncheck the "No routing outside the grib". 

 

2) Select a constant wind at 0 kt (Parameters > Forecasts > Unique wind):

 

3) Give a speed motor (Parameters > Boat > Boat): 
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ROUTING FROM THE BOAT 
SimSail can route from the boat (if its position is received) to the second waypoint in the route or to a 

waypoint. 

 

From the boat 
Go to Parameters > Method > Method -> check "Start from the boat." In this 

case, the first waypoint in the route is replaced by the current position of the 

boat and the route continues with the second waypoint, the third, etc. 

To an active waypoint 
Go to Parameters > Method > Method -> check "To the active wpt". 

An active waypoint is a waypoint received by SimSail through the NMEA 

sentences 0183. This means that a device, often the GPS has entered a waypoint. 

When checked, the route is coloured in red as well as the active waypoint. The routing will be carried out 

from the boat to the active waypoint. 
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BOAT CONFIGURATION 
The main characteristic of the boat is based on its polar. The polar file must be located in User / Documents / 

SimSail / Polars. You can adjust its strength for the day and the night. The angle of upwind and downwind 

can be degraded when using an autopilot or medium quality helmsman. You can choose to run the engine 

below a certain speed. The routing takes into account the tacking speed. 

 

Set of sails 
You can choose to assign a particular set of sails. To do this, you must create a file quite similar to the polar 

file. The best way to do this is as follows, using the First 31.7 polar as an example. The two necessary 

software are a text editor like Notepad (https://notepad-plus-plus.org) and a spreadsheet (Excel® from 

Microsoft or Calc from Libre Office https://fr.libreoffice.org/discover/calc). 

Here is the polar of the First 31.7 copied from the First 31.7.pol file to a spreadsheet. 

 

Then, for each wind force and for each angle, the boxes must be filled in with text that represents the sail 

configuration. No space is allowed. You can colour the boxes on the spreadsheet for clarity. 

TWA 4 6 8 10 12 14 16 20 25 30 35

32 2.23 3.34 4.24 4.86 5.23 5.46 5.58 5.7 5.65 5.37 4.29

36 2.61 3.86 4.78 5.36 5.72 5.92 6.03 6.16 6.18 6.07 5.78

40 2.95 4.3 5.21 5.77 6.07 6.23 6.33 6.45 6.5 6.46 6.33

45 3.32 4.74 5.66 6.13 6.36 6.49 6.59 6.71 6.78 6.78 6.71

52 3.74 5.2 6.09 6.45 6.64 6.76 6.85 6.98 7.07 7.1 7.08

60 4.07 5.56 6.38 6.7 6.87 6.99 7.09 7.23 7.34 7.4 7.42

70 4.32 5.82 6.57 6.92 7.09 7.22 7.33 7.5 7.66 7.75 7.81

80 4.39 5.89 6.63 7.03 7.27 7.41 7.54 7.75 7.93 8.06 8.13

90 4.46 6.05 6.72 7.03 7.34 7.57 7.72 7.95 8.14 8.29 8.38

100 4.54 6.09 6.8 7.12 7.32 7.52 7.77 8.07 8.26 8.4 8.6

110 4.4 5.96 6.73 7.17 7.44 7.64 7.83 8.16 8.52 8.88 9.21

120 4.05 5.61 6.54 7.07 7.47 7.8 8.03 8.44 8.97 9.5 10.06

135 3.3 4.82 6 6.69 7.17 7.6 8.02 8.88 9.88 10.82 11.71

150 2.56 3.87 5.02 5.99 6.64 7.11 7.53 8.4 10.02 12.08 14.11

160 2.25 3.41 4.5 5.48 6.28 6.83 7.26 8.1 9.47 11.6 14.28

170 2.05 3.12 4.14 5.09 5.93 6.55 7.01 7.8 8.95 10.76 13.15

180 1.91 2.9 3.87 4.77 5.6 6.28 6.78 7.55 8.53 10 12.01

https://notepad-plus-plus.org/
https://fr.libreoffice.org/discover/calc


SimSail User Manual – Version 5.9 

32 
 

 

The text is free but without space. This is the one that will be displayed on the screen when the "set of sails" 

tool is selected when displaying a route. 

In the example shown, the choice of texts is as follows: M for Main Sail, J for Jib (genoa), S for Symmetrical 

Spinnaker. 

- M0J2  : Main sail without reef (« 0 ») and J2 (Solent jib) 

- M0J3  : Main sail without reef and J3 (ORC) 

- M1J3  : Main sail with 1 reef and J3 

- M2J4  : Main sail with 2 reefs and J4 (ORC with reef) 

- M-J4  : Main sail down (“-“) and J4 

- M0S2  : Main sail without reef and S2 (Medium spinnaker) 

- M0S4 : Main sail without reef and S4 (Heavy spinnaker) 

- M1S4 : Main sail with 1 reef and S4 

When the table is completed, copy all the boxes to a file called “First 31.7.sail” located in User / Documents / 

SimSail / Sails. 

4 possible configurations for a same boat 
SimSail users often have one boat and thus use a single polar. But this does not mean that the boat always sail 

under the same conditions. For example, in racing, we will not turn on the engine when in cruise it will be the 

case. The average speed of the boat will be higher with a full crew than in solo. Etc. 

Therefore, SimSail offers the possibility of having up to 4 configurations of boat. One can quickly select a 

configuration with keys [1] to [4] or by displaying the boat selector. A configuration only concerns the 

parameters contained in the boat tab (below). 

TWA 4 6 8 10 12 14 16 20 25 30 35

32 M0J2 M0J2 M0J2 M0J2 M0J2 M0J2 M0J2 M1J3 M2J4 M2J4 M-J4

36 M0J2 M0J2 M0J2 M0J2 M0J2 M0J2 M0J2 M1J3 M2J4 M2J4 M-J4

40 M0J2 M0J2 M0J2 M0J2 M0J2 M0J2 M0J2 M1J3 M2J4 M2J4 M-J4

45 M0J2 M0J2 M0J2 M0J2 M0J2 M0J2 M0J2 M1J3 M2J4 M2J4 M-J4

52 M0J2 M0J2 M0J2 M0J2 M0J2 M0J2 M0J2 M1J3 M2J4 M2J4 M-J4

60 M0S2 M0J2 M0J2 M0J2 M0J2 M0J2 M0J2 M1J3 M2J4 M2J4 M-J4

70 M0S2 M0S2 M0J2 M0J2 M0J2 M0J2 M0J2 M1J3 M2J4 M2J4 M-J4

80 M0S2 M0S2 M0S2 M0J2 M0J2 M0J2 M0J2 M1J3 M2J4 M2J4 M-J4

90 M0S2 M0S2 M0S2 M0S2 M0J2 M0J2 M0J2 M0J3 M1J3 M2J4 M-J4

100 M0S2 M0S2 M0S2 M0S2 M0S2 M0J2 M0J2 M0J3 M1J3 M2J4 M-J4

110 M0S2 M0S2 M0S2 M0S2 M0S2 M0J2 M0J2 M0J3 M1J3 M2J4 M-J4

120 M0S2 M0S2 M0S2 M0S2 M0S2 M0S2 M0J2 M0J3 M1J3 M2J4 M-J4

135 M0S2 M0S2 M0S2 M0S2 M0S2 M0S2 M0S2 M0S4 M1J3 M2J4 M-J4

150 M0S2 M0S2 M0S2 M0S2 M0S2 M0S2 M0S2 M0S4 M1S4 M1S4 M-J3

160 M0S2 M0S2 M0S2 M0S2 M0S2 M0S2 M0S2 M0S4 M0S4 M1S4 M-J3

170 M0S2 M0S2 M0S2 M0S2 M0S2 M0S2 M0S2 M0S4 M0S4 M1S4 M-J3

180 M0S2 M0S2 M0S2 M0S2 M0S2 M0S2 M0S2 M0S4 M0S4 M1S4 M-J3



SimSail User Manual – Version 5.9 

33 
 

 

You can edit the names of the configurations with the "Edit" button. 

 

As soon as a parameter on this page is changed, it is automatically saved in the current configuration. 

ANALYSIS OF THE RESULTS 
The results of a routing can be analyzed in several ways. 

First with the routing visualization toolbar. The boat can move forward on the route using the keys arrows 

([Left] and [Right]) and view the conditions at a particular point of routing as in the example below. 

Boat Edition of the polar 

Selector of configurations 

Edition of the names 

of the configurations 

The choice of the name of 

the configurations is free 
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Icon Propeller selected: No engine most of the time (green colour).  

 

 

  

Visualization 

of the 

routing Apparent 

Wind 

Heading of 

the boat 

Icon Propeller 

Course Over 

Ground 

(In orange) 

True 

Wind 
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Icon Variation of the Wind selected. 

 

 

Icon Day/Night selected. Day is in green and night is in red. 

 

 

  

Icon 

Apparent wind speed 

Icon Day / Night 
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Icons Wind and Current selected. 

 

 

Icon Set of Sails selected 

 

 

In general, performing “a” routing consists of making a large number of simulation by varying the parameters. 

It is the interest of the simulation. 

 

Icon Current 

Icon Wind 

Icon Set of Sails 
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Simulation and visualization for analyzing and understanding the sequence of weather events combined with 

the performance of the boat. This allows to control its route and intelligently follow the navigation 

conditions. 

The variation of parameters to the margin may bring a different routing. If routing takes a polar at 80% but in 

reality it is 90%, in the end instead of going east would have had perhaps go west. Scan settings (Parameters 

> Method > Scanning 1) is to test the robustness of its routing. 

By varying the polar (Parameters > Method > Scanning 1 -> Polar), we see that if we go slowly or quickly, the 

routing takes us to different places. 

 

The best is to extensively use the scan parameters: 

- The boat can go faster or slower ; 

- The wind can be stronger or lower than expected; 

- Wind can be advanced or delayed relative to the forecast; 

- The current can be stronger or lower than expected; 

- The current can be advanced or delayed (up to two hours in the Channel); 

- The departure time may be different from the time of simulation. 
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Below, starting between 10:00 and 16:00 gives different routes. 
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EXPORT OF ROUTING DATA 
The optimal route can be exported in GPX format. Go to Parameters > Method > Routings -> Export the 

calculated route. 

 

The following route was imported into OpenCPN and each isochrone point is marked with the date and time 

to which the boat is supposed to reach. 
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One can also export a table of all data along the route (extension "csv"). 

 

  

Time LAT LON BTW DTW CD CS TWD TWS SWD SWS S/E TWA AWA AWS HDG BSP COG SOG Set of Sails

11/04 - 08:00:00 43°N 34' 920 005°W 39' 640   19.8 °  452.1 M   27.4 °    0.5 kt  320.1 °    5.6 kt  324.4 °    5.8 kt Voile   63.4 °   35.6 °    9.0 kt   27.8 °    4.70 kt   27.8 °    5.17 kt M0S2

11/04 - 08:50:00 43°N 38' 715 005°W 36' 880   19.8 °  447.4 M   87.9 °    0.5 kt  315.8 °    8.4 kt  318.3 °    8.1 kt Voile   65.4 °   39.7 °   11.5 kt   23.8 °    5.48 kt   28.2 °    5.70 kt M0J2

11/04 - 09:40:00 43°N 42' 900 005°W 33' 783   19.7 °  442.8 M  124.4 °    0.6 kt  320.0 °   12.2 kt  320.9 °   11.6 kt Voile   63.0 °   43.0 °   15.1 kt   23.8 °    5.80 kt   30.2 °    5.72 kt M0J2

11/04 - 10:30:00 43°N 47' 015 005°W 30' 472   19.6 °  438.1 M   67.2 °    0.2 kt  339.3 °   16.4 kt  340.1 °   16.4 kt Voile   44.1 °   33.4 °   20.7 kt   24.2 °    5.52 kt   25.6 °    5.67 kt M1J3

11/04 - 11:20:00 43°N 51' 268 005°W 27' 653   19.6 °  433.7 M   95.0 °    0.4 kt  355.8 °   18.7 kt  356.9 °   18.6 kt Voile   46.8 °   36.4 °   22.9 kt   43.7 °    5.67 kt   46.4 °    5.90 kt M1J3

11/04 - 12:10:00 43°N 54' 653 005°W 22' 712   19.4 °  429.2 M   32.7 °    0.2 kt  357.2 °   18.8 kt  357.5 °   19.0 kt Voile   48.0 °   37.4 °   23.2 kt   45.5 °    5.72 kt   45.1 °    5.91 kt M1J3

11/04 - 13:00:00 43°N 58' 126 005°W 17' 872   19.1 °  424.8 M   22.7 °    0.2 kt  359.9 °   20.9 kt    0.1 °   21.1 kt Voile   41.9 °   33.6 °   25.4 kt   42.1 °    5.53 kt   41.4 °    5.72 kt M2J4

11/04 - 13:50:00 44°N 01' 695 005°W 13' 500   19.0 °  420.3 M  349.2 °    0.4 kt  359.6 °   18.2 kt  359.3 °   18.6 kt Voile   47.7 °   37.0 °   22.8 kt   47.0 °    5.70 kt   43.7 °    5.93 kt M1J3

11/04 - 14:40:00 44°N 05' 261 005°W 08' 762   18.7 °  415.6 M  351.3 °    0.7 kt  358.3 °   16.9 kt  358.0 °   17.6 kt Voile   49.4 °   37.9 °   21.8 kt   47.4 °    5.73 kt   42.1 °    6.14 kt M1J3

11/04 - 15:30:00 44°N 09' 050 005°W 03' 991   18.5 °  410.9 M   15.0 °    0.5 kt  353.9 °   16.2 kt  354.6 °   16.7 kt Voile   43.0 °   32.8 °   21.1 kt   37.6 °    5.48 kt   35.7 °    5.98 kt M1J3

11/04 - 16:20:00 44°N 13' 093 004°W 59' 945   18.3 °  406.1 M   26.9 °    0.4 kt  347.6 °   16.3 kt  348.5 °   16.6 kt Voile   49.0 °   37.1 °   20.8 kt   37.5 °    5.69 kt   36.8 °    6.09 kt M1J3

11/04 - 17:10:00 44°N 17' 153 004°W 55' 708   18.2 °  401.0 M   10.5 °    0.6 kt  344.8 °   16.7 kt  345.7 °   17.3 kt Voile   51.7 °   39.4 °   21.3 kt   37.4 °    5.78 kt   34.9 °    6.34 kt M1J3

11/04 - 18:00:00 44°N 21' 481 004°W 51' 494   18.0 °  396.0 M   20.0 °    0.6 kt  345.6 °   17.2 kt  346.7 °   17.7 kt Voile   50.5 °   38.7 °   21.8 kt   37.2 °    5.76 kt   35.6 °    6.33 kt M1J3

11/04 - 18:50:00 44°N 25' 762 004°W 47' 202   17.8 °  391.1 M   38.0 °    0.5 kt  342.5 °   17.5 kt  343.7 °   17.8 kt Voile   43.3 °   33.5 °   22.1 kt   27.0 °    5.52 kt   27.9 °    5.99 kt M1J3

11/04 - 19:40:00 44°N 30' 166 004°W 43' 934   17.7 °  386.2 M   55.5 °    0.5 kt  343.3 °   18.0 kt  344.7 °   18.1 kt Voile   41.9 °   32.6 °   22.5 kt   26.7 °    5.47 kt   29.0 °    5.90 kt M1J3

11/04 - 20:30:00 44°N 34' 465 004°W 40' 598   17.6 °  381.3 M   69.3 °    0.7 kt  344.6 °   18.6 kt  346.7 °   18.7 kt Voile   49.7 °   38.6 °   22.9 kt   36.4 °    5.77 kt   39.8 °    6.36 kt M1J3

11/04 - 21:20:00 44°N 38' 532 004°W 35' 843   17.4 °  376.6 M   82.0 °    0.5 kt  345.4 °   19.3 kt  346.8 °   19.3 kt Voile   49.6 °   38.8 °   23.4 kt   36.4 °    5.78 kt   39.5 °    6.11 kt M1J3

11/04 - 22:10:00 44°N 42' 455 004°W 31' 293   17.2 °  372.9 M   51.4 °    0.5 kt  346.8 °   19.3 kt  348.0 °   19.5 kt Voile   48.3 °   40.2 °   22.6 kt   36.4 °    4.31 kt   37.8 °    4.75 kt M1J3

11/04 - 23:00:00 44°N 45' 577 004°W 27' 886   17.0 °  369.3 M   58.2 °    0.5 kt  348.7 °   19.4 kt  350.0 °   19.6 kt Voile   46.3 °   38.5 °   22.7 kt   36.3 °    4.26 kt   38.5 °    4.71 kt M1J3

11/04 - 23:50:00 44°N 48' 643 004°W 24' 447   16.8 °  367.0 M   19.8 °    0.7 kt  358.3 °   19.3 kt  359.0 °   20.0 kt Voile   41.8 °   35.0 °   23.2 kt  317.2 °    4.13 kt  324.8 °    4.48 kt M1J3

12/04 - 00:40:00 44°N 51' 677 004°W 27' 463   17.2 °  364.2 M   32.6 °    0.8 kt    6.5 °   18.1 kt    7.6 °   18.8 kt Voile   41.8 °   34.7 °   22.1 kt  325.8 °    4.11 kt  335.6 °    4.51 kt M1J3

12/04 - 01:30:00 44°N 55' 092 004°W 29' 652   17.6 °  361.3 M   63.2 °    0.9 kt   10.9 °   16.8 kt   13.3 °   17.3 kt Voile   42.0 °   34.3 °   20.6 kt  331.4 °    4.09 kt  344.2 °    4.16 kt M1J3

12/04 - 02:20:00 44°N 58' 426 004°W 30' 985   17.9 °  358.8 M   92.1 °    0.6 kt   13.1 °   16.4 kt   15.1 °   16.6 kt Voile   42.1 °   34.1 °   19.8 kt  333.1 °    4.08 kt  341.0 °    3.82 kt M1J3

12/04 - 03:10:00 45°N 01' 432 004°W 32' 447   18.2 °  356.2 M   88.5 °    0.3 kt   20.8 °   16.4 kt   21.8 °   16.5 kt Voile   48.4 °   39.0 °   19.6 kt  333.4 °    4.25 kt  337.3 °    4.13 kt M1J3

12/04 - 04:00:00 45°N 04' 601 004°W 34' 324   18.5 °  353.4 M   52.2 °    0.3 kt   30.4 °   15.5 kt   30.8 °   15.9 kt Voile   58.0 °   46.4 °   18.6 kt  332.8 °    4.43 kt  337.1 °    4.50 kt M0J2

12/04 - 04:50:00 45°N 08' 052 004°W 36' 392   18.9 °  350.5 M   51.6 °    0.4 kt   33.9 °   15.5 kt   34.4 °   15.9 kt Voile   62.2 °   49.7 °   18.4 kt  332.2 °    4.50 kt  337.3 °    4.59 kt M0J2

12/04 - 05:40:00 45°N 11' 576 004°W 38' 487   19.3 °  347.9 M   80.6 °    0.2 kt   37.9 °   14.6 kt   38.4 °   14.7 kt Voile   66.7 °   52.6 °   17.0 kt  331.6 °    4.53 kt  333.9 °    4.47 kt M0J2

12/04 - 06:30:00 45°N 14' 918 004°W 40' 812   19.7 °  345.5 M  269.4 °    0.2 kt   42.7 °   12.8 kt   42.2 °   12.6 kt Voile   71.1 °   54.3 °   14.7 kt  331.1 °    4.51 kt  329.2 °    4.59 kt M0J2

12/04 - 07:20:00 45°N 18' 199 004°W 43' 589   20.1 °  342.3 M  273.8 °    0.2 kt   48.3 °   11.4 kt   47.6 °   11.3 kt Voile   77.1 °   52.2 °   13.9 kt  330.5 °    6.02 kt  329.1 °    6.12 kt M0J2

12/04 - 08:10:00 45°N 22' 567 004°W 47' 307   20.7 °  338.9 M  354.3 °    0.3 kt   51.4 °   11.4 kt   50.3 °   11.6 kt Voile   80.5 °   55.0 °   13.9 kt  329.8 °    6.08 kt  330.8 °    6.34 kt M0J2

12/04 - 09:00:00 45°N 27' 172 004°W 50' 966   21.4 °  335.4 M   15.2 °    0.5 kt   52.6 °   12.3 kt   51.4 °   12.6 kt Voile   82.2 °   57.8 °   14.8 kt  329.1 °    6.18 kt  332.0 °    6.51 kt M0J2

12/04 - 09:50:00 45°N 31' 953 004°W 54' 586   22.0 °  332.1 M   33.3 °    0.3 kt   55.3 °   12.0 kt   54.8 °   12.3 kt Voile   86.2 °   60.3 °   14.2 kt  328.6 °    6.19 kt  331.0 °    6.33 kt M0J2

12/04 - 10:40:00 45°N 36' 561 004°W 58' 228   22.7 °  328.4 M  342.3 °    0.2 kt   60.2 °   11.3 kt   59.1 °   11.3 kt Voile   81.1 °   55.0 °   13.6 kt  338.0 °    6.06 kt  338.2 °    6.27 kt M0J2

12/04 - 11:30:00 45°N 41' 403 005°W 01' 000   23.3 °  324.8 M  315.5 °    0.3 kt   63.9 °   10.5 kt   62.1 °   10.4 kt Voile   84.5 °   56.1 °   12.5 kt  337.7 °    5.96 kt  336.5 °    6.28 kt M0J2

12/04 - 12:20:00 45°N 46' 193 005°W 03' 985   23.9 °  321.2 M  320.4 °    0.8 kt   65.9 °    9.8 kt   61.3 °    9.6 kt Voile   83.9 °   54.2 °   11.7 kt  337.3 °    5.85 kt  335.3 °    6.63 kt M0S2

12/04 - 13:10:00 45°N 51' 207 005°W 07' 297   24.6 °  317.6 M  329.5 °    0.9 kt   66.9 °    8.8 kt   61.0 °    8.7 kt Voile   84.0 °   52.6 °   10.9 kt  337.0 °    5.73 kt  336.0 °    6.63 kt M0S2

12/04 - 14:00:00 45°N 56' 246 005°W 10' 524   25.3 °  314.0 M  355.0 °    0.7 kt   71.1 °    8.1 kt   66.5 °    8.3 kt Voile   89.7 °   55.3 °   10.1 kt  336.7 °    5.69 kt  338.7 °    6.35 kt M0S2

12/04 - 14:50:00 46°N 01' 168 005°W 13' 286   26.0 °  309.7 M    8.8 °    0.9 kt   70.7 °    7.4 kt   65.1 °    7.9 kt Voile   78.5 °   47.4 °   10.5 kt  346.6 °    5.54 kt  349.6 °    6.36 kt M0S2

12/04 - 15:40:00 46°N 06' 368 005°W 14' 668   26.6 °  304.8 M   21.3 °    1.2 kt   70.5 °    7.2 kt   64.0 °    8.1 kt Voile   67.5 °   40.9 °   11.4 kt  356.5 °    5.50 kt    0.9 °    6.62 kt M0J2

12/04 - 16:30:00 46°N 11' 873 005°W 14' 540   27.0 °  300.6 M   15.4 °    0.8 kt   68.4 °    7.3 kt   63.5 °    7.8 kt Voile   76.9 °   46.3 °   10.6 kt  346.7 °    5.52 kt  350.4 °    6.27 kt M0S2

12/04 - 17:20:00 46°N 17' 014 005°W 15' 802   27.6 °  297.0 M    1.6 °    0.2 kt   66.1 °    7.4 kt   64.4 °    7.5 kt Voile   77.7 °   46.1 °   10.1 kt  346.7 °    5.43 kt  347.3 °    5.66 kt M0S2

12/04 - 18:10:00 46°N 21' 608 005°W 17' 298   28.2 °  293.4 M  335.0 °    0.4 kt   63.4 °    7.6 kt   60.5 °    7.6 kt Voile   73.8 °   44.0 °   10.5 kt  346.7 °    5.45 kt  346.0 °    5.83 kt M0S2

12/04 - 19:00:00 46°N 26' 310 005°W 19' 003   28.8 °  289.4 M  350.9 °    0.3 kt   60.7 °    8.1 kt   58.6 °    8.2 kt Voile   61.9 °   37.8 °   11.8 kt  356.8 °    5.44 kt  356.4 °    5.74 kt M0J2

12/04 - 19:50:00 46°N 31' 081 005°W 19' 432   29.3 °  285.7 M  329.9 °    0.5 kt   58.5 °    8.4 kt   54.8 °    8.5 kt Voile   67.9 °   41.8 °   11.8 kt  346.9 °    5.59 kt  345.4 °    6.11 kt M0J2

12/04 - 20:40:00 46°N 36' 004 005°W 21' 298   30.0 °  281.6 M   13.5 °    0.4 kt   58.3 °    8.3 kt   56.2 °    8.7 kt Voile   59.2 °   37.0 °   12.4 kt  357.0 °    5.47 kt  358.2 °    5.90 kt M0J2

12/04 - 21:30:00 46°N 40' 909 005°W 21' 521   30.5 °  277.3 M   81.8 °    0.7 kt   55.8 °    8.3 kt   57.8 °    8.9 kt Voile   60.6 °   38.1 °   12.6 kt  357.2 °    5.53 kt    4.3 °    5.64 kt M0J2

12/04 - 22:20:00 46°N 45' 590 005°W 21' 007   30.9 °  274.7 M  103.5 °    0.3 kt   52.4 °    8.3 kt   54.3 °    8.5 kt Voile   66.9 °   46.1 °   10.8 kt  347.4 °    4.19 kt  351.8 °    4.04 kt M0J2

12/04 - 23:10:00 46°N 48' 920 005°W 21' 706   31.4 °  271.8 M   19.2 °    0.1 kt   53.5 °    8.7 kt   53.0 °    8.8 kt Voile   55.5 °   38.8 °   11.6 kt  357.5 °    4.05 kt  358.1 °    4.17 kt M0J2

13/04 - 00:00:00 46°N 52' 384 005°W 21' 871   31.8 °  269.0 M  306.7 °    0.2 kt   57.6 °    9.3 kt   56.3 °    9.2 kt Voile   58.7 °   41.4 °   11.9 kt  357.6 °    4.15 kt  355.5 °    4.28 kt M0J2

13/04 - 00:50:00 46°N 55' 935 005°W 22' 285   32.2 °  265.8 M   20.9 °    0.3 kt   63.1 °    9.7 kt   62.0 °    9.9 kt Voile   64.2 °   46.1 °   12.4 kt  357.8 °    4.28 kt  359.2 °    4.54 kt M0J2

13/04 - 01:40:00 46°N 59' 709 005°W 22' 367   32.6 °  262.6 M  359.8 °    0.8 kt   66.8 °   10.6 kt   63.1 °   10.9 kt Voile   75.1 °   55.4 °   12.8 kt  348.0 °    4.47 kt  349.7 °    5.23 kt M0J2

13/04 - 02:30:00 47°N 03' 988 005°W 23' 508   33.3 °  258.9 M   29.3 °    1.2 kt   68.8 °   11.4 kt   65.2 °   12.4 kt Voile   77.0 °   58.7 °   14.1 kt  348.1 °    4.57 kt  356.5 °    5.55 kt M0J2

13/04 - 03:20:00 47°N 08' 598 005°W 23' 922   33.9 °  254.8 M   44.2 °    1.4 kt   69.1 °   12.4 kt   66.7 °   13.6 kt Voile   68.3 °   53.0 °   15.8 kt  358.4 °    4.51 kt    8.6 °    5.55 kt M0J2

13/04 - 04:10:00 47°N 13' 166 005°W 22' 909   34.3 °  250.8 M   60.1 °    1.2 kt   68.9 °   13.3 kt   68.2 °   14.5 kt Voile   69.5 °   54.6 °   16.6 kt  358.7 °    4.56 kt   10.0 °    5.22 kt M0J2

13/04 - 05:00:00 47°N 17' 444 005°W 21' 799   34.8 °  247.3 M   79.7 °    0.8 kt   70.5 °   13.6 kt   71.0 °   14.4 kt Voile   72.0 °   56.6 °   16.4 kt  358.9 °    4.59 kt    8.3 °    4.78 kt M0J2

13/04 - 05:50:00 47°N 21' 378 005°W 20' 955   35.2 °  243.9 M  106.7 °    0.7 kt   78.6 °   12.4 kt   80.1 °   13.1 kt Voile   80.9 °   62.5 °   14.5 kt  359.2 °    4.64 kt    8.2 °    4.48 kt M0J2
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CONNEXION TO A NAVIGATION SYSTEM 
SimSail can receive data from a GPS or a navigation system or other instrument emitting NMEA 0183 

sentences. Done via serial port (Serial tab) or Wi-Fi (Network tab). 

 

Boat data can be displayed and configured. 

 

A click on the circle at the top right of the screen automatically refreshes the screen. 

• Green: connected to GPS and auto refresh. A “S” appears in the green indicator if the Simulation mode is 

on. 

• Red: connected and screen not refreshed automatically. 

Screen is refreshed automatically 

Boat 

Boat 

Repeater 

Repeaters 
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• Gray: not connected to GPS and screen not refreshed automatically. 

In navigation mode, click on the icon to refresh the screen. If SimSail receives NMEA data, the icon turns 

green. During the calculation of a routing, the screen is automatically refreshed (icon becomes red). 

A left click on the Boat icon centres the boat in the window. 

A right click on the Boat icon opens the configuration of the boat display.  

 

 

A left click on the Repeaters icon displays or hides all the repeaters.  

 

A right click on the Repeaters icon displays a window that authorizes the 

configuration of the vectors of the boat and the repeaters. 

 

 

 

 

A right click on a repeater displays the following window: 

 

The following data can be selected in a repeater: 

Date & Time, Boat Position, Boat Heading, Boat Speed, Boat Course Over Ground, Boat Speed Over Ground, 

Boat Velocity Made Good, Apparent Wind Angle, Apparent Wind Speed, Depth, Water Temperature, Reset 

Log, Bearing To Waypoint, Distance To Waypoint, Time To Go, Estimated Time of Arrival, Waypoint Closure 

Velocity, Grib True Wind Direction, Grib True Wind Speed, Grib Current Direction, Grib Current Speed, Grib 

Pressure, Grib Wind Gust, Grib Total Cloud Cover, Grib Accumulated Precipitation, Grib Convection, Grib Air 

Temperature, Grib Relative Humidity, Grib Wave Height, Grib Wave Wind Direction, Grib Swell Direction, 

Calculated True Wind Direction, Calculated True Wind Speed, Calculated Current Direction, Calculated 

Current Speed, Calculated Surface Wind Angle, Calculated Surface Wind Direction, Calculated Min Surface 

Wind Direction, Calculated Average Surface Wind Direction, Calculated Max Surface Wind Direction, 

Calculated Surface Wind Speed, Calculated Min Surface Wind Speed, Calculated Max Surface Wind Speed, 

Polar Speed, Polar Speed Percentage, Polar Speed Upwind, Polar Speed Downwind, Polar VMG Upwind, 

Polar VMG Downwind, Polar True Wind Angle Upwind, Polar True Wind Angle Downwind, Polar Apparent 

Wind Angle Upwind, Polar Apparent Wind Angle Downwind 

REPEATER GRAPH 
A left click on certain repeaters opens a graph on the left side of the main window. Not all repeaters have 

this possibility.  
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ANALYSIS OF PERFORMANCE 
In order to configure easily ashore the repeaters, a tool is dedicated: 

 

 

Simulation 
After clicking on the "Analysis of Performance" icon, select the 

"Simulation" tab then click on "Start simulation". 

 

 

 

 

Repeaters appear with refreshed data every second. These data are extrapolated from the wind, current and 

wave gribs. The boat follows the route if there is one, from the first to the second point of the route. If no 

route exists, a default is created. Center the boat to highlight it. 
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Note that the "S" in the green connecting circle at the top right means that Simulation mode is active. 

To close it, select "Analysis of Performance" then the "Simulation" tab and click on "Stop Simulation". 

Trace 
SimSail can record the trace of the boat and display it later as it would have been a routing. 

 

 

 

SimSail can record the trace of the boat. The trace is a 

simple sequence of navigation points with no other data 

than successive positions. 

 

 

 

NMEA Data 
SimSail can save all NMEA data ("Record" tab) and open them to view a navigation ("Analyze" tab). 
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The display of the 

NMEA data 

appears like a 

routing without 

isochrones. At 

each time step, 

the parameters 

are displayed for 

analysis. 

 

  

Conditions met by the boat 

at this position 
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Comparison of records 
SimSail can make two records of different length in order to compare them. Click on “GO” for record A, then 

button “STOP” appears. The same for record B.  

 

When SimSail has two records, a button appears with “Analyse”. 
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AIS 
The AIS targets can be displayed. 

 

By clicking on a target, a window appears. 
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MOB (MAN OVER BOARD) 
Click on the icon MOB changes the display. The waypoint MOB is centered on the screen with a zoom max. 6 

repeaters appear that give the bearing and distance to MOB. 

 

WEATHER GRAPH 
Left click on the map over a wind grib and select “Weather graph”. Two parameters can be selected. 
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TRAJECTORIES OF PARTICLES 
There are two ways to visualize the trajectory of particles. 

Like EarthWindMap (https://earth.nullschool.net), by pressing the [U] key. Please note, this visualization is 

very attractive but does not correspond in any way to reality. One has the impression of correctly tracking 

the air particles when this is not the case. 

 

We can convince ourselves of this by pressing the [Y] key which displays the real paths of a particle of air 

(wind) and water (tidal current). 

 

https://earth.nullschool.net/
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TIDE GRAPH 
Select in the main menu, sub menu “Current”, the icon “Tides”. 

 

 

By clicking on a rectangle of tide, the tide graph appears. 
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By clicking on the graph, one can display more information. 

 

 

HOW TO INSTALL THE SHOM TIDAL STREAMS 

 

The SHOM tidal streams are not provided with SimSail but SimSail can read them. 

 

Purchase the streams on the SHOM website: 

http://diffusion.shom.fr/produits/courants-maree/courants-2d.html 

http://diffusion.shom.fr/produits/courants-maree/courants-2d.html
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For the creation of an account, see https://diffusion.shom.fr/customer/account/create/ 

 

Once you get the file named “C2D.7z”, you need to decompress it with the program 7z (freeware) 

downloadable at http://www.7-zip.org/ 

You obtain a folder named “C2D” where you have the following folders and files: 

 

Open the first folder “CD_COURANTS2D” and you should have: 

 

Open the folder named “DONNEES” (Means data in English)   

and you should have 9 folders: 

 

Into the folder “Data/Currents” of SimSail (normally under Program 

Files), create a new folder named “Shom” and copy all the folders above with their 

contents under the new folder Shom of SimSail. You should have something like that: 

 

 

 

To run properly, SimSail needs the 9 folders from 557 to 565. 

When the installation is correct, close and open SimSail. Under Parameters > Forecasts > Currents, you can 

select now in the list view the SHOM. In case of difficulty, contact the author. 

 

THE AUTHOR HAS NO LINK WITH THE SHOM. 

THE FILES OF THE SHOM ARE NOT INCLUDED WITH THE SIMSAIL PACKAGE. 

THE USE OF THE SHOM DATA IS THE SOLE RESPONSIBILITY OF THE USER. 

  

https://diffusion.shom.fr/customer/account/create/
http://www.7-zip.org/
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TRACK CHANGES 
 

CHANGES 5.9 (Dec 2022) 

- Fixed: correct barbs on wind arrows until 100 kt 

- Fixed: NMEA 2000 when converted to NMEA 0183 sentences 

- Fixed: when a type of raster is not available, switch to the other type 

- Fixed: crashes are less frequent in video mode 

- New style of window (without title bar). Access via Parameters/Options/Interface 

- New set of icons for the main toolbar. Icons can be modified 

- New convenient Panel for the list of the routings 

- New: Grib files (wind, currents & waves) can be deleted from the Parameters dialog box (right click) 

- New: Right click on the gradient icon shows the figures 

- New: Mouse wheel over certain buttons (wind, currents & waves) switches between the files 

- New: Key F8 saves a capture of the window in the download folder 

- GreatCircle username & password are now encrypted in the registry (technical set) 

- Character set is Unicode in all the code (technical set) 

CHANGES 5.8 (Sep 2022) 

- Added Google Maps® combined with Raster charts (when they are both selected) 

- Added laylines upwind & downwind (distance and time to go) (right click) 

- Added Google Maps 

- Added shortcut 'T' for Trace 

- Added a button at the bottom to show/hide the trace of the boat 

- Added: possibility to delete a grib file (wind, current or wave) from the Parameters dialog box 

- Added: Horizontal dilution of precision of GPS is displayed when mouse is over the connexion button 

- Fixed: Measure of distance is now correctly displayed when distance is less than 1000 m 

- Configurations of the gribs (wind, currents and waves) are now saved automatically 

- Parameters dialog box: gribs can be sorted out by reference time 

- Rendering accelerated when viewport has not changed 

CHANGES 5.7 (Apr 2022) 

- Fixed routing on small routes 

- Added two openstreetmamp versions (stamen toner & terrain) 

- Added optional highly detailed world coastlines (from openstreetmap) 

- Added bathymetry from the European Marine Observation and Data Network 

- Added scale information 

- Added buttons at the bottom for rapid access to boat display 

- Improved speed of routing calculation 

- Improved scheme of information around the boat 

- Improved grid 

CHANGES 5.6 (Dec 2021) 

- Speed of routing increased 

- AIS: list of sorted targets displayed in a window 

- AIS: CPA graphically displayed when a target is selected 

- AIS: colours of targets can be modified 
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- New scheme of information around the boat 

- GSHHS World Coastline updated 

- Wi-Fi: UDP mode added 

- Alarm added when connection is lost 

- New colours for the gradient of wind 

CHANGES 5.5 (Nov 2021) 

- Keys "Prior" and "Next" change the wind grib 

- MOB: drift position displayed 

- AIS improvements 

- At low scale, boat is rendered by circles 

- After minimisation of the window, parameters of auto refresh are restored 

- Tide dialog box: date improvements 

- Fixed csv file from conversion of a NMEA file 

- Results dialog box: currents lag is in minutes 

- Fixed: a polar edited is correctly saved 

- Fixed: several issues with NMEA file 

CHANGES 5.4 (May 2021) 

- New algorithm of routing 

- Barometric pressure gradient added (right click on Pressure icon) 

- Initial aperture of scanning has been augmented 

- Steps of scanning have been extended 

- Function for the route 'Go around the land' added 

- In popup menu, some menus added 

- In routing panel, a small 'v' for VMG has been added in AWA cell 

- In routing, gusts of wind slows the boat speed (when ticked) 

- ETA and WCV added to the repeaters 

- Angles of 000° replaced by 360° 

- New design of several icons 

- New design of the tooltips 

- Fixed AIS for pleasure boats 

- Fixed distance from position displayed under wifi connection 

- Fixed zoom under dpi+ screen 

- Fixed isobars in special situations 

- Fixed moon phase 

- Fixed several bugs 

- Stability increased 

- Minor design improved 

CHANGES 5.3 (Nov 2020) 

- Night display 

- Several bugs fixed 

CHANGES 5.2 (Jul 2020) 

- Atlas of currents 

- Water heights of French ports (SHOM 2019) 

- Bugs fixed 
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CHANGES 5.1 (Feb 2020) 

- New SnMap (updated raster maps sold by ScanNav) 

- New Set of Sails 

- New WiFi connexion 

- New trajectory of air and water particles from one point (Y key) 

- New animation of wind like Earth Wind Map (U key) 

- Meteogram: direct access to wind gribs 

- NMEA: DBT added 

- Map grid reviewed 

- Numerous small improvements 

- Fixed bugs 

Version 5.0 (Aug 2019) 

- Runtime or Now added for Great Circle grib request 

- Graph of repeater data fixed 

- Sun and moon data 

- Numerous bugs fixed 

- Spanish language (from Antonio Ñape) 

Version 4.9 (Jun 2019) 

- Graph of data (by one click on a repeater) 

- Better font for routing panel 

- Size of gribs is displayed before downloading 

- Raster charts can be in several folders 

- New repeaters added 

- Fixed: center gribs if on date line 

- Fixed: length of the arrows in routing display 

- Fixed: cTWS in CSV file converted from NMEA file 

- Fixed: color of repeater is better selected 

- Fixed: last grib of current is displayed after downloading 

- Fixed: NMEA Sentence GLL correctly read 

- Several bugs fixed 

Version 4.8 (Mar 2019) 

- Can load gribs directly from Great Circle (with a valid account) 

- Can read the gribs from XyGrib (new grib library) 

- New repeaters 

- Several bugs fixed 

- More stable version 

Version 4.7 (Jan 2019) 

- On main toolbar, most of icons have two functions (click L or R) 

- Some icons on main tool bar have been redesigned 

- Access to the nearest tide from any location on the map (click R) 

- Convective available potential energy added (CAPE)  

- Relative Humidity added 

- Routing can avoid thunderstorms (CAPE > 1000 J/kg) 
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- Routing can avoid too high waves 

- Display of the boat configuration in the title of the window 

- Better display of BSB Charts that have the same scales 

- New weather graph 

- Coloured currents much more visible 

- Several bugs fixed 

- Save trace: a name based on current date is proposed by default 

- Offset depth for sounder repeater 

Version 4.6 (Dec 2018) 

- Gribs of waves (total height, wind waves and swell waves direction) 

- Fix negative temperature in weather graph 

- Trace can be saved 

- New repeaters (best VMG speed and angles, grib waves) 

- Simulation in order to configure repeaters 

Version 4.5 (Nov 2018) 

- Fixed: size of the main bar rectangle when size of button is less than 32 

- Fixed: certain maps could not be displayed 

- Grid of map improved 

- Frame per seconds of BSB charts improved 

- Auto Refresh is stopped when dialog box of parameters is opened 

- New context menu about raster charts 

- Fixed several minor bugs 

- Fixed Accumulated Precipitation 

- Fixed layer of wind other than 10 m above sea level 

- Weather Graph improved 

- Fixed display of negative temperature 

- Fixed repeater TTG 

Version 4.4 (Sep 2018) 

- Fixed: Date of routing was not according to the time bar 

- Fixed: Bug in Repeaters icon 

- Key to get access to Analysis of the performance is 'A' 

- Repeaters are better positioned on the right (they do not overlap the main bar) 

- On repeaters, the angles have 3 digits 

- Depth is no more at 0 when not received 

- F4 key centres correctly the gribs of wind 

- At the beginning of a trace, the first waypoint is correct 

- Names of marks can be displayed bigger (more readable) 

- Tooltip of keys of movies are above the repeaters 

- Keys movies tooltip, the time step is displayed 

- In weather graph, the data are better displayed 

- A click on the weather graph updates the main window 

- New icon on upper right that gives access to the refreshment of the screen 

- Fixed: Position of 'repeaters configuration' window on HPI screens 

- Automatic name for the saving of routings 

- Automatic name for the saving of conversion 
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- Automatic name for the saving of NMEA data 

- Route saving accessible by popup menu 

- Fixed: Percentage of polar in repeater when upwind or under engine  

- New repeater added (Time To Go) 

- Fixed: MOB Display on HPI screens 

- BSB Maps of same scale can be displayed simultaneously 

- Weather graph can be selected only if the mouse is on a grib 

- Measure of distance completely reviewed (multi segments now) 

- Legends of weather reviewed 

Version 4.3 (Jun 2018) 

- Animation of gribs and routings with movie controls 

- Faster display of wind parameters 

- Minor bugs fixed 

Version 4.2 (May 2018) 

- Fixed waypoint got from navigation system 

- Fixed time bar invisible when unique wind 

- Performance test added 

- Tooltips of the bars are no more hidden by the repeaters 

- C and L are inverted in the main bar 

- Display of previous routings fixed 

- AIS targets have labels 

- Temperature can be selected in a grib request 

- Time bar do not disappear after interruption of routing 

- On polar drawing, angles and speeds figures have been added for better reading 

- MOB function added in the main bar 

- OpenStreetMap correctly displayed when dateline is visible 

- PRESS parameter fixed in Saildocs email 

- Design of dialog boxes Weather and Tide improved 

- New polars added 

Version 4.1 (Mar 2018) 

- New toolbars with new icons 

- Surface temperature added 

- Management of marks 

- New display of navigation data repeaters (configurable) 

- Several minor bugs fixed 

Version 4.0 (Jan 2018) 

- AIS implemented 

- Several bugs fixed 

- Improvements in routing procedure 

- Time zone difference in analysis of trace 

- Length of arrows of the boat can be adjusted 

- Trace of the boat added 

- Convert NMEA File to CSV File for spreadsheet Version 3.9 

- Numerous bugs fixed 
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Version 3.9 (Nov 2017) 

- Tide graph 

- Improvements on NMEA phrases 

Version 3.8.1 (Oct 2017) 

- Reading of grib1 from BSH (Bundesamt für Seeschifffahrt und Hydrographie) 

Version 3.8 (Oct 2017) 

- Meteogram available (wind and pressure) 

- Visualisation of wind stability in a routing 

- Number of BSB charts is no more limited 

- Position of the boat is saved at the end of the session 

- Improvements on High Definition Screen (High DPI) 

- When SimSail is minimized, processor is no more used 

- Better visibility of tooltips 

- Degradation of VMG Downwind 

- Crash report 

- Better management of routings 

- Numerous bugs fixed 

Version 3.7 (Jul 2017) 

- BSB maps 

- Key F5 displays the current time 

- Key M displays the BSB maps 

- Improvement in display of navigation data 

Version 3.6 (Apr 2017) 

- Display default streams when outside grib of currents 

- Fix tides 

- Fix opening of bz2 files 

Version 3.5 (Feb 2017) 

- Display of several routings simultaneously 

- Compatible high dpi screen 

- Fixed : delete old gribs 

- MapQuest no more available 

- Improved : calculation of VMGs 

- Fixed : suppress stored routings 

- Fixed : management of panels 

- New tool Measure of distance 

- Fixed several minor bugs 

- Popup menu (right click) cannot be selected on a panel 

- Big gribs are better managed with less use of memory 

- Fix Dialog box Routings 

- Progress bar improved 

Version 3.4 (Dec 2016) 
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- Kml format improved 

- Fixed: suppress an empty list of routings 

Version 3.3 (Nov 2016) 

- Memory leaks fixed 

- Daylight time zone fixed 

Version 3.2 (Jun 2016) 

- Recording and analysis of the trace (NMEA flow) 

- Configuration of boats has been simplified 

- Information of the boat has been updated 

- Fixed several regressions 

Version 3.1 (May 2016) 

- Faster rendering with multi-processing (using all logic units of the microprocessor) 

- Faster calculation of routing with multi-processing 

- Select a zone and send an email to download a grib from SailDocs and Squid 

- Select a zone and create a cache to use OpenStreetMap offline 

- Added OpenSeaMap 

- Faster interpolation of polar and more precised 

- Improved time step for automatic time step 

- New polars (Elan 45, Furia 332, Gibsea 106, Ovni 365, Sun Odyssey 45, Sunshine 38) 

- Patches without the need to reset all the parameters 

- Added the visualisation of the direction of the current in the routing 

- Calculated TWD in Info Boat dialog box corrected 

- Window of Info Boat is not always the topmost (just above the main window of SimSail) 

- Fixed button 'Start Routing' enabled when 'From boat to waypoint' selected 

- Dialog box Routings (Key R) is no more modal (remains open) 

- New barrier can be added even if barriers are locked 

- All windows remain within the screen 

- High DPI screens 

- Shift and left or right keys to tune 1 minute on the time tool 

- Default or SHOM current can have a lower priority 

- Degradation of VMG Upwind added 

- Extrapolation of current when close but outside a square of current 

- Fixed several bugs 

Version 3.0 (Mar 2016) 

- OpenStreetMap 

- Polar edit 

- Kml format for the routes 

- Selector of boats 

- Reasons why routing stopped 

- Unique wind has been reprogrammed 

- Direction and distance from the boat to the cursor  

- Added shortcuts (F1 pour see all) 

- Number of points of current function of zoom 
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- Updates on Routing Panel 

- Accelerated rendering during moves of the map 

- Improvements of time bar 

- Improvements of main toolbar with new icons 

- Panels are mobile 

- Numpad keys moves and zoom the map 

- Multiple gribs of wind with new selection managers 

- Added display of gusts of wind, total cloud cover and accumulated precipitation 

- Multiple gribs of current with new selection managers 

- Improved stability 

- Fix several bugs 

Version 2.9 (Jun 2015) 

- Scan of wind lag added 

- Unique wind can vary 

- Barometric pressure added 

- Routing possible on lake 

- Frame of the route adjusted (Key F3) 

- Improvements on calculations 

- Improvements on visualisation 

- Barriers can be locked 

- Fix minor bugs 

Version 2.8 (May 2015) 

- Local time 

- Major update of the interface 

- New toolbar for visualisation of the routing 

- New status bar with the percentage of polar reached (GPS) 

- Save and open routings 

- Enhancements on serial communications 

- Full NMEA parsing 

- NMEA phrases are displayed in the Com tab of the Options dialog box 

- Names of the waypoints can be permanently displayed 

- Routing Parameters can be saved and loaded 

- Colours are not limited to several values 

- Scan of polars are coloured 

- Colours of currents updated 

- Gpx files have been standardized 

- Fix minor bugs 

Version 2.7 (Apr 2015) 

- Integration of gribs of currents 

- Week-ends and gribs of currents are displayed on the time bar 

- Progress bar during the routing calculations 

- Fix change of folders 

- Fix name of the grib displayed in the routing parameters dialog box  

- Fix overlap of text displayed under the mouse 
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- Fix routing export (GPX format) 

Version 2.6 (Mar 2015) 

- Can read the tidal streams from the SHOM (France) 

- Ctrl key over the tool time to have steps of 10 min 

- Basic logger 

- VMG optimised 

- Can define precisely the points of the route 

- Routing scan with 3 polars and theirs ratings 

- Dutch translation by Erik Bollen 

Version 2.5 (Jan 2015) 

- Internationalization 

- Full great circle (route, ellipses and routing) 

- Infinite map in longitude including normal work around the dateline 

- Multiple routing by scanning different parameters (polar, wind or time) 

- At the end of a routing, display a summary in a window 

- Display the reason why the routing did not reached the final waypoint 

- Waypoints should be at sea to do a routing and incorrect waypoints are marked 

- Routing can be done out of the ellipse 

- Actual currents are displayed when routing progresses 

- Time lag added for the grib 

- grib is correctly aligned on the Mercator map, especially on high latitudes 

- Option added for the grib colours (one colour per knot of wind) 

- Option added to not route outside the grib 

- Main folder of SimSail may be moved 

- At the opening, load all the previous waypoints 

- Option added for the factor of zoom of the map  

- Pending local language of the operating system, GPX files read numbers that have a ‘,’ or a ‘.’ 

- Windows of Routing parameters and Options keep their locations on the screen 

- Tool time improved 

- Popup menus for the route and the barriers have been uniformed and improved 

- Option added to display or not the lakes 

- Management of the barriers and the route refined 

- Menu 'Add waypoints' is now combined with the menu 'Open waypoints' 

- Framing of the grib and the route improved 

- GPS stability improved 

- Routing from the boat 

- Routing can be stopped better with Escape key 

- Auto routing improved 

- Management of the Traffic Separation Schemes improved 

Version 2.3 (Oct 2014) 

- The isochrones routing is 10% faster. 

- The start date and time cannot be selected out of the range of the grib. 

- The non-homogenous gribs can be loaded. It concerned Saildocs which can provide a grib that covers 

two weeks, with a grid for the first week different from the second week. 
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- Several icons of the right panel have been changed. 

- For the dual routing, sailing and engine, the engine is now on when the boat speed is below a threshold. 

- Stability improvements. 

Version 2.2 (Oct 2014) 

- The isochrones routing is much faster (3 times faster than the version 2.1). Abandon of the previous 

method of interpolation of the polar which was a bi-cubic spline interpolation. 

- Stability improvements. 

- Icon Routes changed for clarity. 

- Best finish at the waypoints. 

- GPS and Languages functions are still in development. 

Version 2.1 (Jul 2014) 

- Barriers added. 

- Correction of bugs after intensive use of the software during the summer cruise. 

- GPS function added. 

- Language added. 

Version 2.0 (May 2014) 

- For a better and faster rendering and to avoid developing for two graphics engine, GDI+ is no more 

implemented. Thus XP is no more supported. SimSail is only available for Windows 7 that utilizes 

Direct2D. 

- Isochrones and Intermediate waypoints methods have been implemented. Available for multi segments. 

- Routing avoids the coasts. Quality of the coasts can be changed for the precision of the calculations. 

- Many additional routing parameters. 

- Several additional options of SimSail. 

- Enhanced calculation of the routing. 

- Cities are visible. 

- Map grid of 1° x 1°. 

- Stability improvements. 

Version 1.0 (Feb 2014) 

- Direct2D implemented and choice between Direct2D and GDI+ can be made in dialog box Options. 

- Additional options in the dialog box Options with new tabs. 

- Management of the shorelines GSHHS has been totally rebuilt. The full world is available. 

- SimSail can read the original data that can be downloaded at 

http://gmt.soest.hawaii.edu/files/download (See the file gshhg-gmt-nc4-[version].tar.gz) 

- Automatic quality of the shorelines has been implemented and is visible in the status bar. 

- Routing improved with Counter currents fixed. 

- Display of the winds has been improved. There are more arrows and the colored surface is more 

readable. 

- Several improvements on the toolbar to limit at maximum the refreshment of the window. 

- A bar below the toolbar has been added to better navigate in the grib or in the routing. 

- Display of tides has been added for the main reference ports. 

- F1 key displays the help. Several shortcuts have been added. 

- Speed of rendering has been increased. 

- Stability improved. 

http://gmt.soest.hawaii.edu/files/download
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Version 0.9 (Dec 2013) 

- New dialog box with tabs for the options of SimSail. 

- Toolbar can be hidden when the mouse is not over. This option is saved. 

- Tooltips have been added for the buttons of the toolbar. They can be shown or hidden and this option is 

saved. 

- The name of the waypoints is displayed close to them, under the mouse position. 

- Several colours can be changed in the options dialog box and saved. 

- Folders of gribs, waypoints, routes and polars can be changed and saved. The first time SimSail opens, 

the folders are the default ones. When they are changed with the Options dialog box, they are saved and 

restored. 

- New dialog box with tabs for the routing parameters. 

- The polar can be displayed. Access by the Routing dialog box, Polar Tab. Escape key comes back to the 

normal display. 

- The details of each point of the routing are displayed on the left. Keys, Page Up and Page down, in 

conjunction with Control (10 time steps) or Shift (60 time steps) key allows navigating along the routing. 

- The route is displayed with arrows to see the departure and the arrival. 

- The speed of the boat is calculated in interpolating the polar with a bi-cubic spline. 

- The boat cannot have a course inferior the VMG upwind or superior to the VMG downwind. 

- A unique wind available for the world can be set. 

- Gribs from Zygrib, Ugrib and Meteo Consult can be read. 

- The display of the winds in gradient colours has been improved. 

- The time to calculate a routing has been divided by two. 

- SimSail doesn't need any more msvcr100D.dll. 

- SimSail is now under the license GPL3. 

- When the routing is not in the time or spatial range of the grib, SimSail utilizes the engine. 

- The routing can be exported as a route and can be open in navigation software like OpenCPN or MaxSea. 

- Several optimisations in the rendering. 

- Routing can be done without the currents. 

- Legend of the routing has been added and display of the routing can be selected from the legend on the 

upper right. 

- Memory leaks almost solved. 

Version 0.8 

First release candidate to have been tested by another tester at sea. 

- New toolbar with vertical menu of buttons. 

- Polar can be changed. 

- New routing procedure, in particular when a waypoint of the route is reached. 

Version 0.7 

- Compressed gribs with bz2 extension can be read. 

Version 0.6 

- Enhancement of routing. 

- Lambert projection. 

Version 0.5 (Jul 2013) 
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First release candidate tested at sea during summer 2013. 

- Basic routing. 

Version 0.4 

- Waypoints. 

- Route. 

Version 0.3 

- Currents. 

Version 0.2 

- Shorelines. 

- Grib files. 

Version 0.1 

- Map moving on Win32 C++. 

Version 0.0 (Nov 2012) 

- And if I would develop my own routing software… 

 


